Layers:
Work Layer: We can directly add Business Rules in Work Layer
Data Layer: We can't add Business Rules directly in Data Layer. First we need to Create Data Classes/Data Types

Int Layer: We can't add Business Rules directly in Int Layer. First we need to Create Int Classes

Data Model:

Property Rule:
Property is a Data Model Rule

Data model-> Property

Property Rule is an Instance of Rule-Obj-Property

Work Layer & Work Classes: Use the properties in User Interface design (( Single Value, Page & Adv Properties)
Data Classes: Tables -> Fields ( Single Value Properties)

Int Classes: Request & Response fields ( Single Value Properties)



Property Types:

- Single Value : A Property can hold one value at a time
- Page Properties ( Single Page, Page List, Page Group): A Property can hold Multiple Properties( Reusable Properties)

- Adv Properties: Value List, Value Group : A Property can hold Multiple Values

How many ways to add Property:

3 ways:
- Data Model-Property( Create a Property: Create & Open) - One Property ( Single Value, Page & Adv Properties)
- Data Model-Property( Quick Create a Property: Create & Close)- One Property ( Single Value)

- Using Property Wizard - Multiple Properties at a time ( But we can add only single value properties using wizard Option/ Page Properties)

Single Value Property Parameters:

Property Name/Label: Ex: FName
Property Type: Text
Ul Control: Property Display Format & Basic Validation

Table Type/Configure Field: To add Static Records for Property ( Local List / Prompt List)



Creating Single Value Properties Using Property Wizard:

To Create any Rule in PEGA go to App Explorer:

Pega Dev Studio % ing Tools _

=

O ® localhost N InPrivate &
DEV STUDIO F b Ci DEVELOPMENT
3 applications

Classes Branches

@ ALFA-ALFAAUTO-Work
r SysAdmin
Pega Infinity-

Pinned

Guardrail warnings (last 7 days) View all warnings Refresh Security status

0 out of 33

Severe Moderate Informational




Till 7.4- ( Right Click on Class group -> Create Properties)

From 8 Version-> Wizard Name is View in Data Designer/Create Properties

[ Pega Dev Studio

s =
::y@@!e|
)] i (@ | localhost:8080/prweb/PRServiet/app/ALFAAUTO_/3RgalFemDCaETgAG3yL-riyMIciGoLich*1STANDARD? pzPostDa

DEV STUDIO o L ) +F | DEVELOPMENT

Classes Branches Hide this until the next release Read more on Pega Community

+

@ ALFA-ALFAAUTO-Work

Create

View

Definition

Inheritance

View in data designer

Manage relevant records

Refactor
Refresh ALFA-ALFAAUTO-Work

Refresh all

Guardrail warnings (last 7 days) View all warnings Refresh Security status Refresh

0 out of 33

Moderate Informational

Severe

A

http:/flocalhost:B080/prweb/PRServiet/app/ALFAAUTO_/3RgalFemDCaE7gAG3yL-rlyMiciboLkh*/ISTANDARD? pyActivity=Embed
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Wizard will open

[ Pega Dev Studio

&« )] i (@ | localhost:8080/prweb/PRServiet/app/ALFAAUTO_/3RgalFemDCaETgAG3yL-riyMIciGoLich*1STANDARD? pzPostDa

Pl DEV STUDIO

Home ALFA-ALFAAUTO. .

recendl Data Type: ALFA AUTO Insurance Application case layer
ALFA-ALFAAUTO-Work ~ ALFAAUTO

ontrol w

— Data model Usage Sources Records Views Test cases Settings

Fields
Name T ID
Case ID oyID
o Case status PyStatUSWDrk
Label pyLabel
~+ Add field

T Scope (applies to)

Cover classes

T

Type

Text (single line)

Text (single line)

Text (single line)

Filter

Options

Key: Read-only

Read-only

Actions ~




Add Fields/Properties

i o y z ]
£ Pega Dev Studio X N Q @ o e |
&« = )] i (1 | localhost:8080/prweb/PRServiet/app/ALFAAUTO_/3Rgal FemDCaE7qAG3yL-rlyMIciboLih*/1STANDARD? pzPostDa
“.t DEV STUDIO ~ HH DEVELOPMENT
@ Home ALFA-ALFAAUTO...
Bt Fields Search Q
X v
Name T ID T Scope (applies to) Type Options
....... Case ID pylD Cover classes Text (single line) Key: Read-only
Case status pyStatusWork Case Text (single line) Read-only
Label pyLabel Case Text (single line)
FName FName ALFA AUTO Insurance Application case layer Text (single line) ||
LName LName ALFA AUTO Insurance Application case layer Text (single line) T
Age Age ALFA AUTO Insurance Application case layer Integer ]
EmaillD EmaillD ALFA AUTO Insurance Application case layer Email T
PhoneNo PhoneMo ALFA AUTO Insurance Application case layer Phone T
Country Country ALFA AUTO Insurance Application case layer  Picklist >~ Drop-down list
+ Add field
A

PEGA




For Radio Buttons/ Drop drowns we have to choose a Type: Pick List

For Country Property If you want to Give Dropdown Control set the Type as Pick List.

After Type is Selected, Configure the Pick list Values ( Click on Configure Filed)

Now Click on Configure Field
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/2% DEVSTUDIO ~ P & DEVELOPMENT

e

@ Home ALFA-ALFAAUTO...
(B Data model Usage Sources Records  Views Test cases Settings
— Type
Picklist
Fields g
| Display as 2
Drop-down list
T Radio buttons
Name T ID T Scope (applies to) Type Options Autocomplete
cuLdr
Case ID pylD Cover classes Text (single line) Key: Read-only choices
Case status pyStatuswWork Case Text (single line) Read-only
+ Add choice
Label pyLabel Case Text (single line)
FName FName ALFA AUTO Insurance Application case layer Text (single line) > Advanced =
LName LName ALFA AUTO Insurance Application case layer Text (single line) “ T
Age Age ALFA AUTO Insurance Application case layer Integer - il
EmaillD EmaillD ALFA AUTO Insurance Application case layer Email T
Phoneho PhoneNo ALFA AUTO Insurance Application case layer Phone |
Country Country ALFA AUTO Insurance Application case layer  Picklist ~  Drop-down list
A

PEGA

Add Static Records:
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/2% DEVSTUDIO ~ P & DEVELOPMENT

e

@ Home ALFA-ALFAAUTO...
2 Data model Usage sources Records Views Test cases Settings Drop-down list | A
Picklist options
Fields < Local ~
Choices
. T . Select Country
Name T ID T Scope (applies to) Type Options
India
Case ID pylD Cowver classes Text (single line) Key: Read-only hi
China
Case status pyStatuswWork Case Text (single line) Read-only |Austra|i54 .
Label pyLabel Case Text (single line) + Add choice
FName FMame ALFA AUTO Insurance Application case layer Text (single line) N d d ]
Advance
LName LName ALFA AUTO Insurance Application case layer Text (single line) 1]
Age Age ALFA AUTO Insurance Application case layer Integer “_ |
EmaillD EmaillD ALFA AUTO Insurance Application case layer Email T
Phoneho PhoneMo ALFA AUTO Insurance Application case layer Phone |
Country Country ALFA AUTO Insurance Application case layer  Picklist ~  Drop-down list
A

PEGA

Click on OK
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Pl DEV STUDIO

@ Home

Fields

Name

Case ID

Case status

Label

FName

LName

Age

EmailiD

Phoneho

Country

~+ Add field

ALFA-ALFAAUTO..

)] {n (1 | localhost:8080/prweb/PRServiet/app/ALFAAUTO_/3

ID

pylD

pyStatuswWork

pyLabel

FName

LName

Age

EmaillD

PhoneMo

Country

RgalFemDCaE7

T Scope (applies to)

Cowver classes

Remote Control

AAGD
qAG3Yy

L-rlyMicisoLkh*/1STANDARD? pzPostDa

Type

Text (single line)

Text (single line)

Text (single line)

ALFA AUTO Insurance Application case layer Text (single line)

ALFA AUTO Insurance Application case layer Text (single line)

ALFA AUTO Insurance Application case layer Integer

ALFA AUTO Insurance Application case layer Email

ALFA AUTO Insurance Application case layer Phone

ALFA AUTO Insurance Application case layer Picklist

Refresh Explorer & Expand Data Model to see the Properties

i

Options

Key: Read-only

Read-only

Drop-down list

- 9O®O m .

DEVELOPMENT

Q

PEGA
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(DR (@ | localhost:8080/prweb/PRServiet/3Rg

Pl DEV STUDIO : ALFAAUTO Ins... ™ Configure

Classes Branches Refresh App Explorer .
& next release Pega Community News Refresh

Create > +
N
>

Explorer Inheritance ] ] o
o ALFA-ALFAAUTO-Work  [REKTOn s e Visualize application layers for

. case processes and sections (8.2)
r SysAdmin

In App Studio, you can now easily
pega Inflnlty' visualize the application layers for case
N processes and sections, including work
areas and views. When you click the
Discover gadget for a case process or
section, you are shown a visual
representation of the application
layers. You can open a layer in Dev
Studio to see the rulesets and other
attributes of an application.

The following image shows the
Discover gadget.

Manage and communicate more
. easily in IVA for Email (8.2)
Security status

View all warnings Refresh Refresh To resolve email triage cases more
quickly and efficiently, communication
in Pega Intelligent Virtual Assistant™

Severe Moderate Informational (IvA) for Email is enhanced. You can
0 out of 32 reply to any email address, instead of

Guardrail warnings (last 7 days)

http://localhost:8080/prweb/PRServiet/3Rgal FemDCaETqAGIyL-ryMIciboLkh*/ISTANDARD? pyActivity=Embed-PortalLayout.Rec S50[S racer [) Clipboard L Live Ul Accessibility Performance PEGA

Expand Data Model
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< - 0O @ @ | localhost:80:

/prweb/PRServlet/3Rg

DEV STUDIO I ALFA AUTO Ins... Configure

Classes Branches

Hide this unti| the next release |
+

+

& ALFA-ALFAAUTO-Work
r Data Model

» SysAdmin

Pega Infinity"

Pinned classes

Guardrail warnings (last 7 days) Security status

Refresh

0 out of 32

[7) Clipboard ~ [JLive Ul

View all warnings Refresh

Severe Moderate Informational

gile Workbench [ Current work Scenario Testin N racer
8 FAAN

¢t, Accessibility

Pega Community News  Refresh

Visualize application layers for
case processes and sections (8.2)

In App Studio, you can now easily
visualize the application layers for case
processes and sections, including work
areas and views. When you click the
Discover gadget for a case process or
section, you are shown a visual
representation of the application
layers. You can open a layer in Dev
Studio to see the rulesets and other
attributes of an application.

The following image shows the
Discover gadget.

Manage and communicate more
easily in IVA for Email (8.2)

To resolve email triage cases more
quickly and efficiently, communication
in Pega Intelligent Virtual Assistant™
{IWA) for Email is enhanced. You can
reply to any email address, instead of

Performance

PEGA
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<—EI‘ = Pega Dev Studio

— O @ | localhost:B0

DEV STUDIO

Classes Branches

@ ALFA-ALFAAUTO-Work
¥ Data Mode!
> Property

Age
Country
EmaillD
FName
LName
PhoneNo

» SysAdmin

A
<

Agile Workbench [= Current work

><|—|— ks

/prweb/PRServlet/3Rg

I ALFA AUTO Ins... Configure

Home

Hide this unti| the next release |

+

Guardrail warnings (last 7 days)

Severe

, Scenario Testing

Moderate

Pega Infinity"

View all warnings Refresh

Informational

racer

+

Security status
Refresh

0 out of 32

[7) Clipboard ~ [JLive Ul

¢t, Accessibility

Pega Community News  Refresh

Visualize application layers for
case processes and sections (8.2)

In App Studio, you can now easily
visualize the application layers for case
processes and sections, including work
areas and views. When you click the
Discover gadget for a case process or
section, you are shown a visual
representation of the application
layers. You can open a layer in Dev
Studio to see the rulesets and other
attributes of an application.

The following image shows the
Discover gadget.

Manage and communicate more
easily in IVA for Email (8.2)

To resolve email triage cases more
quickly and efficiently, communication
in Pega Intelligent Virtual Assistant™
{IWA) for Email is enhanced. You can
reply to any email address, instead of

Performance

PEGA



Creating Properties Under Data Model Category using Property Rule:

[ Pega Dev Studio >

)] {n (@ | localhost:8080/prweb/FRServiet/app/ALFAAUTO_/3RgalFemDCaETgAG3yL-rlyMIciGoLikh*/1STANDARD? pzPostDa

Classes Branches

+

@ ALFA-ALFAAUTO-Work
r Data Model

Association Pega Infinity"

View > Data Flow

Create properties Data Page
Data Set
Data Transform
Edit Input

Edit Validate
External Data Flow
Field Value

Property Alias

Property Qualifier ail warnings (last 7 days) View all warnings Refresh Security status Refresh

0 out of 33

Severe Moderate Informational

Introduced b
http:/flocalhost:B080/prweb/PRServiet/app/ALFAAUTO_/3RgalFemDCaE7gAG3yL-rlyMiciboLkh*/ISTANDARD? pyActivity=Embed
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Pl DEV STUDIO

Home MNew

Create Proper
Classes  Branches perty Create and open

Property Record Configuration

@ ALFA-ALFAAUTO-Work
r Data Model Label % dentifier

v SysAdmin Gender  Edit
» Technical A short description or title for this record

View additional configuration options

Context
(®) ALFA AUTO Insurance Application Apply to * Add to ruleset %
ALFA Insurance Application ALFA-ALFAAUTO-Work 4 ALFAAUTO  ~ | 01-01-01 w
Ul Kit _
Pega Platform View all

Current work item

PEGA




Click on Create & Open

[ Pega Dev Studio

_ - . &
::y@@gel
)] i (1 | localhost:8080/prweb/PRServiet/app/ALFAAUTO_/3Rgal FemDCaE7qAG3yL-rlyMIciboLih*/1STANDARD? pzPostDa

DEV STUDIO R 4 £ 5 | DEVELOPMENT

Home New

Edit Property: Gender, [Available]
I Actions ~ Save
ALFA-ALFAAUTO-Work ~ Gender ALFAAUTO:01-01-01

General Advanced Specifications History

Property type

Text(change)

Data access

'@:‘ Manual At run time, the user adds data to this property through the Ul. Data transforms and
Automatic reference to class instance (linked) other rules may be required to support this workflow.

~ Display and validation

Ul Contro
pxTextinput
Parameters
Table type
None

PEGA




Type: Text

Ul Control: pxRadioButtons

[ Pega Dev Studio e ontrol w

&« )] i (@ | localhost:8080/prweb/PRServiet/app/ALFAAUTO_/3RgalFemDCaETgAG3yL-rlyMIciboLich*1STANDARD? pzPostDa

Pl DEV STUDIO

Home New

Edit Property: Gender [Available]
Actions ~
ALFA-ALFAAUTO-Work ~ Gender ALFAAUTO:01-01-01

General Advanced Specifications History

Property type

Text(change)

Data access

'@:‘ Manual At run time, the user adds data to this property through the Ul. Data transforms and
Automatic reference to class instance (linked) other rules may be required to support this workflow.

~ Display and validation

Ul Contro

pxRadioButtong 4

Parameters

Table type
None




TableType: Select Local List & Add Table Values

1 Pega Dev Studio

“— O m () | localhost:8080/prweb/PRServiet/app/ALFAAUTO_/3Rgal FemDCaE7gAG3yL-rlyMIciboLkh*/1STANDARD? pzPostDa

Pl DEV STUDIO

Home New

Edit Property: Gender [Available] »

Data access

'@:‘ Manual At run time, the user adds data to this property through the Ul Data transforms and
Automatic reference to class instance (linked) other rules may be required to support this workflow.

~ Display and validation

Ul Control
pxRadioButtons

Parameters

Table type
Local List ~

Table values

1 Male

2 |Female

E

PEGA

Or Use PromptList under table type:
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DEVELOPMENT

/&  DEVSTUDIO e i) : () &

Home New

Edit Property: Gender [ Available] Save ~ ¥

TR T Faimgr = o guuS Uatd PTOpE e

Automatic reference to class instance (linked) other rules may be required to support this workflow.

~ Display and validation

Ul Control

pxRadioButtons 4
g Parameters

Table type
Prompt List ~

[[] Display only (not for validation)

Prompt values

Standard value Prompt value
M Male

i F Female

PEGA

Save Property



Add Pincode Using Quick Create Option:

= Paga Dev Studio |4+ o~

O 0]

localhost:o0

DEV STUDIO Create

Launch web interface

Pl

Classes Branches
Read more ofi the Pega Community |

+

Hide this,until the next release

@ ALFA-ALFAAUTO-Work
» Data Model

Data Flow
View > Data Page
Data Set

Pega Infinity-

Create properties

e

Data Transform
Edit Input
Edit Validate
External Data Flow
Field Value
Property Alias

Property Qualifier

<

Guardrail warnings (last 7 days) Security status

View all warnings Refresh Refresh
: o Cmremen "t----ate [nformational
httpy//localhost:3090/prweb/PRServiet/3Rgal FemDCaE TgAG3yL-riyMIciboLkh*/!STANDARD? pyActivity =Embed-PortalLayout.Rec 0 out of 32

Agile Workbench [E] Current work [) Clipboard L] Live Ul

¢k, Accessibility

Pega Community News  Refresh

In App Studio, you can now easily
visualize the application layers for case
processes and sections, including work
areas and views. When you click the
Discover gadget for a case process or
section, you are shown a visual
representation of the application
layers. You can open a layer in Dev
Studio to see the rulesets and other
attributes of an application.

The following image shows the
Discover gadget.

To resolve email triage cases more
quickly and efficiently, communication
in Pega Intelligent Virtual Assistant™
{IWA) for Email is enhanced. You can
reply to any email address, instead of
only to the email address of an IVA

Performance

PEGA
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Pl DEV STUDIO

Home New

Create Property

L Property Record Configuration

Label %
Pincode
A short description er title for this record
g View additional configuration options
App
Context

(®) ALFA AUTO Insurance Application
F ALFA Insurance Application
Ul Kit
Pega Platform

Current work item

Cancel

|dentifier
Pincode  Edit

Apply to % Add to ruleset %

ALFA-ALFAAUTO-Work ALFAAUTO 01-01-01 +

View all

Now Below Label Click on View Additional Configuration Options Link

Create and open

PEGA




= Pega Dev Studio

- h " Q @ ! e ) ® nic
35 k" @
“— )] i (@ | localhost:2080/prweb/PRServlet/app/ALFAAUTO_/3RgalFemDCaETgAG3yL-ryMIcicoLkh*/1STANDARD? pzPostDa
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Pl DEV STUDIO

DEVELOPMENT
Home New

Create Property

Cancel Create and open Create and close

P, Property Record Configuration

Label % |dentifier

Pincode Pincode  Edit

A short description er title for this record
g Remove additional configuration options

Additional configuration options
Data type

[ optimize for reporting

[] Optimize for reporting on descendant classes

Context

(®) ALFA AUTO Insurance Application Apply to *

Add to ruleset %
ALFA Insurance Application ALEA-ALFAAUTO-Work ALFAAUTO

i

v 01-01-01 ~

ﬁ E ! ["IE._

PEGA

No Need to Change type here.

Now Click on Create & Close Button, After Clicking on Button, Property will be created & tab will be closed.



Add State & City Properties using Drop down & Add static Records

Open Property Wizard:

[ Pega Dev Studio

()] i (@ | localhost:8080/prweb/PRServiet/app/ALFAAUTO_/3RgalFemDCaETgAG3yL-riyMIciGoLich*1STANDARD? pzPostDa

Classes Branches , Read more on Pega Community

+

@ ALFA-ALFAAUTO-Work

+ Data Model

Create > Pega Infinity
View

>
Create properties

Guardrail warnings (last 7 days) View all warnings Refresh Security status Refrash

0 out of 33

Severe Moderate Informational
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Add State Property:

ng Tools
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/A% DEVSTUDIO ~ P & i
Home ALFA-ALFAAUTO...
Fields
T
Name T ID T Scope (applies to) Type
Age Age ALFA AUTO Insurance Application case layer Integer
Case ID pylD Cover classes Text (single ling)
;‘;P Case status pyStatusWork Case Text (single line)
L Country Country ALFA AUTO Insurance Application case layer Picklist
EmaillD EmaillD ALFA AUTO Insurance Application case layer Email
FName Fhame ALFA AUTO Insurance Application case layer Text (single line)
Label pyLabel Case Text (single line)
LMame LMame ALFA AUTO Insurance Application case layer Text (single line)
Phonemo PhoneMo ALFA AUTO Insurance Application case layer Phone
State State ALFA AUTO Insurance Application case layer  Picklist
+ add field

Add City Field:

2
¢
LGS
a
i
m
(e
oy

Options

Key: Read-on

Read-only

Drop-down li:

~ | Drop-down list

Type
Picklist

Display as
Drop-down list

Picklist options
Local ~

Choices

Select State
TS

KA

TN

+ Add choice

PEGA




3 Pega Dev Studio * Aaa » Remote Control «
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/2% DEVSTUDIO ~ P I
Home ALFA-ALFAAUTO..
PICKIIS
T Display as
T ID T Scope (applies to) Type Options Drop-down list
Picklist options
Age Age ALFA AUTO Insurance Application case layer Integer
Local b
Case ID pylD Cover classes Text (single line) Key: Read-on  choices
select Cit
Case status pyStatusWork Case Text (single line) Read-only y
g Hyderabad
A Country Country ALFA AUTO Insurance Application case layer Picklist Drop-down it
PP
|Bangalore|
L EmaillD EmaillD ALFA AUTO Insurance Application case layer Email
Chennai
FName FMame ALFA AUTO Insurance Application case layer Text (single line)
+ Add choice
Label pyLabel Case Text (single line)
LName LMame ALFA AUTO Insurance Application case layer Text (single linge)
Phoneho PhoneMo ALFA AUTO Insurance Application case layer Phone
State State ALFA AUTO Insurance Application case layer Picklist Drop-down list
City City ALFA AUTO Insurance Application case layer  Picklist ~ | Drop-down list

+ add field

After Creating Properties, to view all properties under Data Model , Clcik on Refresh App Explorer
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DEV STUDIO

Classes Branches ,Read more on Pega Community

+

@ ALFA-ALFAAUTO-Work
¥ Data Model
~ Property Pega Infinity-
Age
City
Country
EmaillD
FName
Gender
LName
PhoneNo
Pincode
Salary
State Guardrail warnings (last 7 days) view all warnings Refresh Security status Refresh
r SysAdmin

Severe Moderate Informational
» Technical 0 out of 33
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